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FDOT Civil 3D Labeling

This class will focus on labels styles and concepts such as the 
creation of label styles, how to use the Label Style Composer and its 
various settings, override individual labels with other label styles, create 
new label sets, create and use expressions, style control and display 
properties of Label Styles that are included with the FDOT State kit and 
manipulation of the Label location settings.

Prerequisites: 

 The most current/latest version of the FDOT Civil 3D State kit 
should be installed. This will ensure you that you have the label 
styles demonstrated in this session.
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Session Objectives:

 Styles In General – Learn how aspects of the software is controlled 
through the Prospector and Setting tab on the Toolspace palette.

 Object Styles – Briefly explore the collection of Object Styles on 
the Setting Tab.

 Label Styles – Discuss and learn about the many factors that go 
into the creation of labels.

• Label Style Composer and its various settings that the control 
look and display.

• Creation of label styles.

• Create and use expressions.

 Label Sets – Combined individual Label styles that can combined 
together.

 Label Location – Applying labels and location manipulation.

3



FDOT Civil 3D Labeling

Styles In General

Every aspect of Civil 3D is now controlled through Tool Space, a 
collection of data, settings and styles are stored IN the drawing. Civil 
3D does not store data in external databases as other Autodesk 
software has done previously.

First off lets take a look at Tool Space a briefly explore its functionality.

1. To launch Tool Space, select the Home Tab.

2. Under the Pallets panel the first and largest icon you see is the 
Toolspace icon.
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Toolspace: Prospector tab

The Prospector tab is a collection of
data objects that are present in the active
drawing (DWG) file. The collections are
organized in a tree structure with overall
collection categories and object data
within those collection. The primary
collections displayed include points, point
groups, surfaces, sites, pipe network,
corridors, assemblies and subassemblies.

To access any of the data within the
Toolspace, simply expand each collection
item to expose the object data.

5

Styles In General



FDOT Civil 3D Labeling

Toolspace: Settings Tab

The Settings tab is a collection of
styles that Civil 3D utilizes to control
objects, labels, tables, commands
and other settings. On this tab,
styles are organized for different
object types. You can modify these
object types and then save as a
template for future use or for
developing your standards.

To access any of the styles or
commands within the settings tab,
simply expand each collection item to
expose .
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Object Styles

What is a style? It basically defines how Civil 3D objects look.

It also simplifies the process of knowing where to go to change 
objects or labels.
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Object Styles

Every Civil 3D object property has style field with a style assigned.

Because the style is now a property rather than a series of 
procedures, users can simply assign predefined style to their objects 

to meet FDOT requirements instead of following pages of 
procedures and workbooks.
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Label Styles – Discuss and learn about the many factors that go 
into the creation of labels.

Before you begin creating a style, ask your self… 

What is it that I want to label? 

How do I want the label to look like or display? 

Do I want the label to be plan or model space readable? 

Label styles control the annotation of object data within a drawing. 
All label styles are created using the Label Style Composer. 
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 Label Styles - Label Style Composer and its various settings.

The Label Style Composer is a collection of tabs that control label 
creation and display characteristics. It is consistent throughout the 
entire program making the interface easy to navigate and simplifies the 
creation process.

You can edit the label setting at the drawing level, the object level 
and the label style level.

The Label Style Composer is comprised of five Tabs:
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-Information-

-General-

-Layout-

-Dragged States-

-Summary-

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Information: This tab controls the name of the style, a brief 
description, and information regarding who created of modified the 
style.
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The style has to have a 

name. The “Created by” 

and “Date created” fields 

are automatically filled in. 

Description does not 

have to be filled out, but 

since it’s there… why not 

use it?

Label Styles
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 Label Styles - Label Style Composer and its various settings.

General: Use this tab to specify the Text style, layer visibility and 
orientation. FDOT text styles have been applied to all FDOT label 
styles. These fonts are annotative. The text size change based on the 
drawing scale assigned.
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Label: Text style assigned, whether or not 

the label is visible in the drawing and the 

layer assigned.

Behavior: Specifies the orientation 

reference of the label.

Plan Readability: Specifies the text rotation 

to insure all text components in labels can 

be read easily in plan view.

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Layout: The layout Component properties define the appearance, 
location, and orientation of that particular component.
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The Anchor Component: Allows the user to attach 

a component to a feature (Object) or another 

component.

Component Name: You can use an 

arrangements of components to create an 

appropriate label. 

Delete a component by selecting the “X”. 

All the properties configured are applied to 

each component separately. 

The Anchor Point: Defines the justification of the 

label that its applied to.

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Layout: Continued-Text: This section is where you control the 
size, rotation, placement and the display of text
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Text Height: Represents the text size in plotted inches.

Attachment: Defines the justification of the label that 

its applied to.

Rotation Angle: Angle is based upon the Anchor 

Component, Anchor Point, and Text Attachment.

Contents:(See Next Page).

X,Y Offsets: Modify the offset distances by 

applying a +/- value in inches.

Misc. Object Properties: By Layer allows the Layer 

Manger to control color and Line weight based on the 

layer specified on the General tab.

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Layout: Continued…
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Contents: Click in the Value cell to the right of 

Contents to access the Text Component Editor.

The Text Component Editor is a collection of object 

data values used in labeling. The values obtained 

from the objects create an appropriate label. Text 

may be entered in conjunction with a property 

value. The Modifier parameters associated with 

the chosen property type will change accordingly.

Delete the current property in the preview 

window first then select a new property 

from the pull down menu. After adjusting 

the Modifier values, select the     icon to 

place the property component in the 

preview window.

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Dragged State: Use this tab to define properties for labels when 
they are dragged away from their insertion points.
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Dragged State Component: Choose how label 

content is displayed after it is dragged from its 

default position. Pick a Border, Background Mask 

or a different Text height once the label is 

dragged. 

Leader:  Choose an arrowhead for the 

leader from the list. Specify the arrow head 

size, whether the leader is visible when 

dragged from its position. Specify is you 

would like a Straight Leader line or a 

curved Spline Leader line.  

Label Styles
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 Label Styles - Label Style Composer and its various settings.

Summary: Use this tab to review all settings for a label style
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Once you’ve made all the 

changes and various settings on the 

Information, General, Layout and Dragged 

State tab. You can quickly review these 

setting all from the Summary tab.  You can 

also use this tab to make changes. This is 

a useful tab once you become more 

familiar with the various settings of a label.  

This is sort of a “One stop shop” setting 

tab.  

Label Styles
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 Label Styles – Review examples for label style settings.

• Examine how to add a Border, Background Mask and change 
linetypes for Single Major Minor Contours.

• Examine how to create and assign Labels and Label Sets for 
alignments.

• Create an FDOTSta-Off-Elev label style using an Object Reference 
Text Component.
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 Example - Examine how to add a Border, Background Mask and 
change linetypes for Single Major Minor Contours.

1. One Toolspace>Settings Tab. Find the FDOT Major or FDOT 
Minor label style’s.  Right-click on either name and choose EDIT. 
Select the Layout tab. On the Border area make the following 
changes.
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• Example - Examine how to assign Labels for alignments.
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Individual Component Label 

Styles on the Settings Tab

Label Styles combined into 

sets from the Settings tab.
Label sets applied to 

objects.
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 Example - Create an FDOTSta-Off-Elev label style using an 
Object Reference Text Component.

1. Launch the C3D Toolspace palette. On the Settings tab navigate 
to Surface>Label Styles> Spot Elevation, right click on the label 
style name “Standard” and choose “Copy…” from the short cut 
menu. Name your new label style something that explains what 
the label is intended to do, for example FDOTSta-Off-Elev.
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2. In the Label Style Composer Dialog box, on the General Tab, 
make the following changes:
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Assign the style FDOT for the Text style.

Choose TextElevLabel to assign layer designation.
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3. Click on the Layout Tab and make the following changes:
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Anchor Point = Bottom Left 

Text height = 0.1”

Attachment = Top Left

Contents = (See next page for editing Contents)
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4. Verify that Surface Elevation is selected for Component Name. 
Click in the Value Colum for Contents to edit the Surface Elevation 
text.
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5. In the Text Component Editor:

A. Delete the existing text in the 

preview window.

B. Type in EL. for the prefix before 

your Surface Elevation.

C. Verify the Modifier Values 

match the settings in the image.

D. Select the Arrow to transfer the 

new settings to the preview 

area on the left.

A
B

C

6. Click OK.

D
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7. Click the Create Component icon and select Reference Text. 

Select Alignment for type. This creates a Referenced Text 

component with property fields you can use to refer to alignment 

data in your label.

8. Click in the Value for name and type Station and Offset for the 
component name.
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9. Change the Attachment for the Text category to bottom left.

10. Click on the “dice” icon to change the contents of the label.
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11. In the Text Component Editor:

A. Delete the existing text in 

the preview window. Type 

in STA. for the prefix 

before your station value.

B. Choose “Station Value” 

from the Properties pull 

down menu.

C. Verify the Modifier Values 

match the settings in the 

image

D. Select the Arrow to 

transfer the new settings 

to the preview area on the 

left.

A

B

C

D
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13. Verify that your preview matches the image as shown. Click OK to 

close the Text Component Editor.
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12. In the Text Component Editor:

A. Choose “OFFSET” from 

the Properties pull down 

menu.

B. Verify the Modifier Values 

match the settings in the 

image

C. Select the Arrow to 

transfer the new settings 

to the preview area on the 

left.

A

B

C



FDOT Civil 3D Labeling

14. Select the Dragged State tab on the Label Style Composer dialog 

box.

15. Change Display for Dragged State Components to As Composed. 

This will ensure that the label maintains the original settings for 

composition and orientation when the label is dragged using grip

16. Click Apply and OK to apply the settings and close the Label Style 

Composer dialog box.
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17. To place the label choose the Annotate Tab, under the Labels and 

Tables Panel.

18. In the Add Labels dialog box for Feature choose Surface, for Label 

type choose Spot Elevation, for Spot elevation label style select 

FDOTSta-Off-Elev. Select Add to place your label.

19. Your drawing must contain a Surface and an Alignment. Follow the 

command prompts to place your new label. Select the label to 

display grips. Select the square grip to drag the label.  Notice the 

dragged state of the label remains as composed.
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Thank You!

Are there any questions?

Are there any comments to improve your experience?

Email me at 

Mike.Racca@dot.state.fl.us

The Civil 3D FDOT State kit is available for download at:

http://www.dot.state.fl.us/ecso/downloads/software/FDOT2014CADDSoftware.shtm
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